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Licensing and Copyright Information 

The software described in this guide is furnished under license agreement and is used in terms of 
accordance only. 

Product Version:  eViewer HTML5 v 5.0.1_21 

Document Version: 2.11 

© 2012-2019 MS Technology. All rights reserved. 

This guide and accompanying software are confidential and proprietary to MS Technology. No part 
of this document can be copied, modified, reproduced, republished, uploaded, or distributed in any 
form by any means without prior authorization of MS Technology. Unauthorized use of the 
information appearing here may violate copyright, trademark and other applicable laws, and could 
result in criminal or civil penalties. 

The information provided in this document is used as a guide only and is subject to change without 
any notice. MS Technology reserves the rights to change and update their product or make changes 
in the context without any obligation to notify any person for such changes. 

MS Technology,                                                                                                                                
P.O. Box 471843                                                                                                  
Charlotte, NC 28247                                                                                                               
USA 

Tel: (704) 544-3403                                                                                                                   
Fax: (704) 544-0262                                                                                                                                 
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Website: www.ms-technology.com 
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1. Getting Started 

This section lets you get acquainted with various sections covered in this user manual which 

further helps you in understanding the product, eViewer HTML5 in a better way. You can also 

understand the purpose of developing such product. This user guide also contains key features 

with the system requirements for proper installation and use of product.     

1.1 Brief about User Guide 

Welcome to the user guide of eViewer HTML5 which is proficient, competent and result-

oriented product. This user guide has been designed for users to understand the software in an 

efficient and effective manner. So we recommend you to carefully go through the user guide 

before launching the product and keep it in a safe, easy accessible place for future reference. 

1.2 Overview 

eViewer HTML5 is a very powerful, yet hassle-free, Zero Footprint viewer for viewing multiple 

formats including TIFF, JPG, PDF, MO:DCA and many others. It is a high-performance document 

viewing solution that enables users to view documents and images from a desktop or any 

mobile device within an internet browser. It uses HTML5, CSS, and JSP/Servlet to give your 

organization the peace of mind that the documents are safe yet provide a portable and dynamic 

viewing solution.  

1.3 Features 

eViewer HTML5 is loaded with rich features that make it complete and outstanding. Some of 

the features are listed below: 

 Documents and images are directly retrieved and viewed through browsers.  

 Hassle-Free Integration: No workstation installation or platform compatibility issues 

due to the use of Java, AJAX, and HTML5 technologies.  

 File Support: Supports most of the file formats as supported by our flagship viewer, MST 

Viewer.  

 Annotation support: Including PDF and MO:DCA annotations.  

 File Conversion: Automatically converts files temporarily into an image format to display 

in an internet browser. Also, provides an option to save the converted file to PDF, TIFF, 

JPEG, GIF, BMP, or back to the original format.  

 Image Processing: Performed on the server to deliver an extremely high-speed 

response.  

 Easy Navigation: Go directly to any page on the document.  

 Printing: Print single and multi-page documents with or without annotations.  
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1.4 Benefits 

eViewer HTML5 provides a number of benefits including: 

 Reduce Overhead and Increase Productivity: Allows companies to reduce a number of 

applications to one efficient universal document and image viewer.  

 Zero Footprint HTML5 Viewer: Compatible with up-to-date internet browsers with zero 

client-side installation needed.  

 Annotations: Access to a number of different annotations including, but not limited to 

redaction, line, arrow, rectangle, circle, text, highlighter, pen, and stamps. 

 Internal Development: All file formats are developed by in-house MST developers and 

do not use any third party APIs. This gives you the ability to have customization, prompt 

resolutions to issues, and release control. 

1.5 Supported File Formats 

eViewer HTML5 supports following file formats: 

IBM proprietary file formats 

 MO:DCA (Mixed Object: Document Content Architecture) 

 IOCA (Image Object Content Architecture) 

 PTK (PTOCA) 

Office file formats 

 DOC (Microsoft Word Document) 

 DOCX (Microsoft Word Document 2007 and above) 

 XLS (Microsoft Excel Spreadsheet) 

 XLSX (Microsoft Excel Spreadsheet 2007 and above) 

 PPT (PowerPoint Presentation) 

 PPTX (PowerPoint Presentation 2007 and above) 

 VSD (Microsoft Visio) 
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Documents 

 PDF (Adobe Portable Document) 

 RTF (Rich Text) 

 TXT (ASCII Text) 

Image file formats 

 ABIC 

 BMP (Windows and OS/2 Bitmap Formats) 

 CAL (CALS Raster) 

 DCX (Paint Brush) 

 DCM (DICOM) 

 EMF (Windows Metafile) 

 GIF(CompuServe GIF) 

 JBG (JBIG) 

 JB2 (JBIG2) 

 JPG(Joint Photographic Experts Group (JPEG)) 

 JPEG-XR (Windows Media Photo / HD Photo (HDP)) 

 JPEG-LS (JPEG Lossless) 

 J2K (JPEG 2000) 

 JP2 (JPEG 2000 Compressed) 

 JPM (JPEG 2000 Part 6) 

 JPX (JPEG 2000 Part 2) 

 PNG (Portable Network Graphics) 

 PNM (Portable aNy Map) 

 PPM (Portable PixMap) 

 PBM (Portable Bitmap Utilities) 

 PCX (Paint Brush) 

 RAS (SUN Raster) 

 TIFF (Tagged Image File) 

 WBMP (Wireless Bitmap) 

 WMF (Windows Metafile) 

 XPM (XPicMap) 
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2. Understanding User Interface (UI) 

eViewer HTML5 has a very user friendly and intuitive user interface that provide quick access to 

all important functions the user needs.   

 

                           

 

 

2.1 The Ribbon  

Ribbon combines the menu bar and toolbar into a single floating pane. The purpose of the 

ribbon is to bring the most popular commands to the forefront, so you don’t have to search for 

the most common commands in the viewer.  

Additionally, the ribbon includes several tabs that are used to reveal different groups of 

commands. Since the ribbon contains both the program's menu options and toolbar 

commands, it cannot be removed from the screen.  

The Ribbon offers ease of use and convenience, with all common actions shown at one place.  

The Ribbon has three parts – tabs, groups, and commands. 

 

Tabs Ribbon 
Groups 

Document View Area 
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Tabs 

The Ribbon has four basic tabs across the top with each tab representing an activity area with 

their own specified commands.  

 

 

By default, the Home tab is displayed when the viewer is opened. 

 

Groups 

Commands are sectioned into groups within each tab. 

                         

 

Commands 

A Command is a button or a box or a menu where you enter information. Commands are 

organized in logical groups that are collected together under tabs.  

 

For example, in the above group Zoom,  ( ), ( ), ( ) are zoom commands. 
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2.2 Toolbars and Tabs 

eViewer HTML5 has four tabs that allow modifying any type of file. Each tab has separate 

groups with specified commands performing their particular task. 

Home Tab 

This is the standard view tab that is comprised of the following groups: Page Navigation, 

Zooming, Rotation, Clipboard, and editing.     

 

 

 

Commands Command Decription 

 

 

 

Zoom In: Increase the magnification percentage of the 

page 

Zoom Out: Decrease the magnification percentage of the 

page  

Rubber Band Zoom: Magnify specific area of the page 

 

 

Rotate Counterclockwise: Rotate the page in an anti-

clockwise direction 

Rotate Clockwise: Rotate the page in a clockwise 

direction 

 

 

 

 

Cut: Cut the selected text or image or annotation from 

the page 

Copy: Copy the selected text or image or annotation 

from the page 

Paste: Insert the copied text or image or annotation at 

the insertion point (cursor) 
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View Tab 

This tab allows to change the view of the document that is comprised of the following groups: 

image scaling, image processing functions, window modification, and other viewing tools. 

 

 

 

Commands Command Description 

 

 

 

 

Fit to Window: Resize the document to fit entirely in the 

window 

Fit to Width: Resize the document to fit in the width of 

the window 

Fit to Height: Resize the document to fit in the height of 

the window 

 

 

 

 

Invert: Invert the color of the page 

 

Flip Page: Flip page either horizontally or vertically 

 

Gray Scale: Range of shades of gray without apparent 

color 

 

Enhance: Enhances the page of a document 

 

 

Tree View: Display tree view structure of the document 

 

Thumbnails: Display thumbnail view of the document 
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Annotation Tab 

This tab contains the annotation tools available with the viewer with additional features - 

adding bookmarks and watermark. 

 

 

 

Command Command Description 

 

Color: Applies border color on the annotation 

 Line: Draw horizontal and vertical lines at 45° 

 

Rectangle: Draws a rectangle 

 

Circle: Draws a circle 

 
Arrow: Draw horizontal and vertical or 45° arrows 

 
Pen: Draws freehand lines and shapes 

 Highlighter: Highlight text on the document 

 Text: Enter text on the page 

 Stamp: Place images or text stamp anywhere on the 

document 

 Polyline: Series of open and connected lines 

 

 

Polygon: Series of closed, connected straight lines 

with the last line connecting back to the first line to 

form a complete shape 

 
Scratch Out: Draw zigzag lines 

 

 

Cross Product: Draws “x” that is used to measure 

the distance horizontally and vertically between two 

points of the image 

 Cloud: Draws cloud with a series of connected lines 

 Arc: Draws an arc 
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Ruler: Draws a line that is used to measure the 

distance between two points of the image 

 
Angle: Measure angle of the image to the nearest 

degree 

 CheckPoint: Review and verify forms 

 SideNote: Allow reviewers to step through each 

SideNote annotation in the opened documents or 

images 

 

Show/Hide Annotation: Show or hide annotations 

made on the page 

 

Add Watermark: Add watermark on the page 

 
Add Bookmark: Add bookmark on the page 

 
Delete: Delete annotations drawn on the page 

 

Redact Tab  

This tab contains redaction functions available in the viewer including the groups for text 

search, redaction reason, and redaction option. 
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3. Common Tasks 

This section lists the operations that can be performed by the eViewer document viewer. 

3.1 Opening Documents  

Documents can be opened in eViewer from the following ECMs: 

 From Microsoft SharePoint 

 From IBM FileNet P8 

 From IBM Content Manager 8 

 From EMC Documentum WebTop 

 From another CMIS ECM system  

Opening Documents from Microsoft SharePoint  

Perform the following steps to open a document from the SharePoint repository: 

1. Open an Internet browser and enter in the SharePoint URL. 

2. The login page appears. 

3. Provide the user name and password. 

4. After successfully logging in, the SharePoint Libraries and Lists will be displayed on the 

left side of the screen. 

 

5. Click on the library from the list of libraries, displayed in the Libraries group. 
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6. The list of folders and documents exist in the selected library are populated on the right 

side of the screen. 

 

7. Perform one of the following: 

 For documents listed in library: Hover the mouse over the document that you want to 

view in the eViewer. A checkbox will appear at the beginning corresponding to the 

document. Select the checkbox and click eViewer HTML5 icon displayed on the ribbon. 

The selected document will be opened in the viewer in a separate window. 

 

 For folders listed in library: Double click on the folder. The list of document exist in the 

folder were populated on the screen. Hover mouse over the document that you want to 

view in the viewer. A checkbox will appear at the beginning corresponding to the 

document. Select the checkbox and click eViewer HTML5 icon displayed on the ribbon. 

The selected document will be opened in the viewer in a separate window.      

Opening Documents from FileNet P8 

Perform the following steps to open a document from FileNet P8 repository: 

1. Open the browser and enter the FileNet P8 URL. 

2. The login page appears. 

3. Provide the user name and password. 

4. The FileNet object stores page appears. 
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5. Select the object stores from the existing list. 

6. The list of folders exists in the object stores were populated on the screen. 

7. Click on the folder whose documents that you want to view in the viewer. 

8. The list of documents exist in the selected folder were displayed on the screen. 

9. Right click on the document that you want to view in the viewer and select Open in MST 

viewer. 

10. The selected document will be opened in the viewer in a separate window.   

Opening Documents from IBM Content Manager 8 

Please contact us to assist you with the integration with Content Manager 8. 

Opening Documents from EMC Documentum WebTop 

Please contact us to assist you with the integration with EMC’s Documentum for WebTop. 

Opening Documents from another CMIS ECM System 

Please review the developer’s guide on the available exposed APIs for connecting to other 

applications. 

 

3.2 Saving Documents 

To save the document, click Save ( ) displayed at the upper right corner of the viewer. 
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3.3 Printing Documents 

The document can be printed by performing the following steps: 

1. Click ( ). 

2. The Print Document dialog box will appear. 

 

3. Provide the range of page numbers to print in From Page and To Page respectively. 

4. Select or clear Print Annotation checkbox to print or not to print annotations made on 

the page. 

5. Select or clear Print Strike Out checkbox to allow strikeout comments to be print or not 

to print on the page. 

6. Select or clear Print Highlight checkbox to allow highlighted text to be print or not to 

print on the page. 

7. Click OK. 

8. The Print dialog box appears. 

9. Under Printer group, select the printer to use (if it is not selected). 

10. Under Copies group, select the number of copies to print 

 

3.4 Thumbnail Window 

The Thumbnail Window displays a miniature representation of the document pages that allows 

easily navigating multi-page documents. Perform the following steps to view thumbnail view of 

a document: 

1. On the View tab, select Thumbnails check box. 



eViewer HTML5                                                                                                    

 
User Manual    
Document Version: 2.11                                                                                                               18 

 

2. The Thumbnail Window will display at the left side of the viewer. 

 

The document can be viewed in the document view area of the viewer by scrolling the bar of 

the thumbnail window. Click on the thumbnail image (page) and the selected thumbnail will get 

open in the right side, that is, in the document viewer area of the viewer. The thumbnail that is 

currently viewed in the document view area of the viewer will be highlighted in the different 

color – signifying that this page is currently being viewed in the document view area of the 

viewer.  

 

The sequence of the pages of the document can be changed in the thumbnail window. The 

most convenient way to move or copy a page of the document is to select and drag it to the 

desired location on the document. The same works here. Just hold the mouse button down 

over the page, scroll it through the thumbnail window and release the mouse, drop the page, 

where the page is to be copied at or moved to.  

Currently viewing page 

Thumbnail Window 

Thumbnail  



eViewer HTML5                                                                                                    

 
User Manual    
Document Version: 2.11                                                                                                               19 

 

3.5 Zooming Text/Image in a Document 

Zoom is a feature that either increases or decreases the size of a page or the size of all the text 

displayed in a page (Text Zoom) in order to improve readability. You can zoom in to get a close-

up view of the file/document or zoom out to see page at a reduced size. Perform the following 

steps to zoom text/image: 

1. On the Home tab, click ( ) to increase the magnification percentage of the page. 

2. On the Home tab, click ( ) to decrease the magnification percentage of the page. 

Rubber Band Zoom  

Another type of zoom that eViewer HTML5 provides is the Rubber Band Zoom that magnifies 

the selected image or text area in order to improve the readability of the image or text. 

Perform the following steps to perform rubber band zoom on the text or image: 

1. On the Home tab, click the Rubber Band Zoom ( ). 

2. Select an area on the page. For this, hold down the left mouse button and drag the 

mouse pointer diagonally. 

3. A box forms between the starting and ending positions of the mouse pointer. 

4. Release the left mouse button when the area has been defined. 

5. The rubber-banded magnified area will display in the center of the screen. 

3.6 Searching Text in a Document 

The eViewer provides text search functionality to enable users to quickly find text information 

in a document. Perform the following steps to search text in a document.  

1. On the Home tab, type the text to search in Search Text box. 

2. Press Enter. 

3. If the result is found, the searched text will be highlighted in the document. 

4. Click  arrows to go to the previous and next matched text.  

5. Select or clear Highlight All checkbox to display all the searched text found in the 

document. 

6. Select or clear Match Case checkbox to search only for words that match the case of the 

word or phrase that has been typed in the text box. This means that the search becomes 

case-sensitive. For example, if you search menu, the result includes all instances of 

menu with this exact spelling but not Menu or MENU. 

7. Click Advanced Search ( ) to search the text with other advanced search options. 
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8. The Advanced Search dialog box will appear. 

 

9. Type the text to search and select the option as per your need. 

 Case-Sensitive: If selected, searches only for words that match the case of the word or 

phrase that has been typed in the text box. This means that the search becomes case-

sensitive. For example, if you search menu, the result includes all instances of menu 

with this exact spelling but not Menu or MENU. 

 Whole words only: If selected, restricts the search to whole words only. Whole words 

are words separated, on both sides, by a space. For example, if you search for edit, the 

result includes instances of edit only not editing, editor, editorial, and edited. 

10. Click Search. 

11. All the matched text will display in the window. 

12. Click on the desired matched text. 

13. The application will bring to the page on which the match was found. 

4. Annotations 

Annotations are comments, notes, markups, explanations, or other types of external remarks 

that can be added to a selected part of the document to point out, explain or illustrate an area 

or item on the document. 

eViewer provides tools to enable users to freely write their comments, sticky notes and add 

markups on documents to help with collaborating with others. Additionally it provides the 

ability to add digital stamps, and other markups to make the eViewer an ideal solution for a 

business workflow environment.  

Annotation marks are saved as annotation data that is stored on a separate file and not on the 

original document. Whenever a user makes an annotation, a file with the same name as the 

document with an extension .xml is created in the current directory. The annotations can also 

be printed with the document if the user chooses. 
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The following are the available annotations that are provided by the eViewer:  

4.1 Line 

The Line annotation tool provides the user with the ability to draw a horizontal, vertical, or lines 

at 45° with the following adjustments: color, thickness, and transparency. The user can perform 

the following steps to create a line annotation: 

1. On the Annotate tab, click Line ( ). 

2. Click where the line to begin, and then drag the mouse to the place where it should end, 

and release the mouse button. 

Edit Properties of Line  

1. Select and right click on the annotation. 

2. The Line Properties dialog box will appear. 

 

3. To set the color of the line: Select the color displayed from the Color group in the 

Annotations tab. 

4. To set the width of the line: Select the width from the Border Width drop down box. 

5. To adjust the transparency of the line: Slide the bar to adjust the transparency of the 

line from Transparency field. 

6. Click OK. 

4.2 Rectangle 

The rectangle annotation tool draws a rectangle with the following available adjustments: line 

and fill color, thickness, and transparency. The user can perform the following steps to create a 

rectangle annotation: 

1. On the Annotate tab, click Rectangle ( ). 

2. Click and drag diagonally on the screen and release the mouse button. 
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Edit Properties of Rectangle  

1. Select and right click on the annotation. 

2. The Rectangle Properties dialog box will appear. 

 

3. To set the color of the border of the rectangle: Select the color from the Color group in 

the Annotations tab. 

4. To set the width of the rectangle: Select the width from the Border Width drop down 

box. 

5. To fill color inside the rectangle: Select the color from the list of colors displayed in the 

Background-Color.  

6. To adjust the transparency of the rectangle: Slide the bar to adjust the transparency of 

the rectangle from Transparency field. 

7. Click OK. 

 

4.3 Circle 

The circle annotation tool draws a circle with the following adjustments: line and fill color, 

thickness, and transparency. The user can perform the following steps to create a circle 

annotation: 

1. On the Annotate tab, click Circle ( ). 

2. Click and drag diagonally on the screen and release the mouse button. 

Edit Properties of Circle  

1. Select and right click on the annotation. 

2. The Circle Properties of dialog box will appear. 
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3. To set the color of the border of the circle: Select the color from the Color group in the 

Annotations tab. 

4. To set the width of the circle: Select the width from the Border Width drop down box. 

5. To fill color inside the circle: Select the color from the list of colors displayed in the 

Background-Color.  

6. To adjust the transparency of the circle: Slide the bar to adjust the transparency of the 

circle from Transparency field. 

7. Click OK. 

4.4 Arrow 

The arrow annotation tool draws a horizontal, vertical or 45° arrow with the following 

adjustments: color, thickness, and transparency. The user can perform the following steps to 

create an arrow annotation: 

1. On the Annotate tab, click Arrow ( ). 

2. Click and drag diagonally on the screen and release the mouse button. 

Edit Properties of Arrow  

1. Select and right click on the annotation. 

2. The Arrow Properties dialog box will appear. 
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3. To set the color of an arrow: Select the color from the Color group in the Annotation 

tab.  

4. To set the width of an arrow: Select the width from the Border Width drop down box. 

5. To adjust the transparency: Slide the bar to adjust the transparency of an arrow from 

the Transparency field. 

6. Click OK. 

 

4.5 Highlighter 

The highlighter annotation tool provides the user with the ability to provide highlight markups 

with the viewer. The user can perform the following steps to create a highlight annotation: 

1. On the Annotate tab, click Highlighter ( ). 

2. Click and drag diagonally on the screen and release the mouse button. 

Edit Properties of Highlighter  

1. Select and right click on the annotation. 

2. The Highlighter Properties dialog box will appear. 

 

3. To fill color inside the highlighter: Select the color from the list of colors displayed in 

the Background-Color. 

4. To adjust the transparency: Slide the bar to adjust the transparency of the highlighter 

from the Transparency field. 

5. Click OK. 
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4.6 Pen 

The pen annotation tool draws freehand lines and shapes with the following available 

adjustments: color, thickness, and transparency. The user can perform the following steps to 

create a freehand line annotation: 

1. On the Annotate tab, click Pen ( ). 

2. Click on the screen and drag the mouse. The mouse will follow your moves. Release the 

mouse button to end your drawing. 

Edit Properties of Pen  

1. Select and right click on the annotation. 

2. The Pen Properties dialog box will appear. 

 

3. To set the color of the freehand line: Select the color from the Color group in the 

Annotation tab.  

4. To set the width of the freehand line: Select the desired width from the Border Width 

drop down box. 

5. To adjust the transparency: Slide the bar to adjust the transparency of the freehand line 

from the Transparency field. 

6. Click OK. 

4.7   Text 

The text annotation tool enters text on a page with the following available adjustments: size 

and color of the font and the text box. The user can perform the following steps to create and 

place any text annotation: 

1. On the Annotate tab, click Text ( ). 

2. Click and drag diagonally on the screen and release the mouse button. 
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3. Double click on the text box to type text in the box. 

4. A cursor will appear on the screen allowing you to type in text.  

5. To finish editing text, click anywhere outside the text box.  

6. To edit the text later, double click on the text.  

7. The text box can be repositioned by dragging the text box border and the size of the text 

box can be adjusted by dragging the selection handles. 

Edit Properties of Text  

1. Select and right click on the annotation. 

2. The Text Properties dialog box will appear. 

 

 

3. To set the border color of the text box: Select the color from the Color group in the 

Annotations tab.  

4. To set the width of the text box: Select the width from the Border Width drop down 

box. 

5. To fill color inside the text box: Select the color from the list of colors displayed in the 

Background-Color. 

6. To adjust the transparency: Slide the bar to adjust the transparency of the box from the 

Transparency. 

7. To set the color of the text: Select the color from the list of colors displayed in the Text 

Color. 

8. To set the font size of the text: Select the size from Font-Size drop down box field. 

9. To set the font family of the text: Select the font family from Text Font Face drop down 

box field. 

10. Click OK. 
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4.8 Stamp 

This tool allows adding wide variety of readymade or custom made stamps on the document. 

You can place images and/or text stamps anywhere on the document. The user can choose 

either from a list of predefined stamps or create their own stamps. The user can perform the 

following steps to create and place a stamp annotation on the document:  

1. On the Annotate tab, click Stamp ( ). 

2. Select the stamp from the list of available stamps. 

 

 

 

 

 

 

Create New Stamp 

All the existing stamps are located in the list of predefined stamps. To create a new stamp, 

perform the following steps: 

1. Click  . 

2. The Stamp dialog box will appear. 

For creating 

new stamps 

Predefined stamps 
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3. Click New Stamp 
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4. Under Stamp Properties group, for the new stamp, select the border and text color, 

thickness and transparency in the Background-Color and Text-Color, Border-Width and 

Transparency fields respectively. 

5. Under Text/Image group, select from the available options the type of new stamp either 

Text or Image. For Text stamp, type the name of the stamp in the text box. For Image 

stamp, click   and explore the image to display. Click OK.  

6. The newly created stamp will be listed in the Total Stamp(s) list box. 

7. The preview of the newly created stamp will display in the Stamp Preview group. 

8. Click OK. 

 

Edit Properties of Stamp   

1. Select and right click on the stamp. 

2. The Stamp Text dialog box will appear. 

 

 

 

3. To set the border color of the stamp: Select the color from the Color group in the 

Annotations tab. 

4. To set the width of the stamp: Select the width from the Border Width drop down box. 

5. To fill color inside the stamp: Select the color from the list of colors displayed in the 

Background-Color. 
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6. To adjust the transparency: Slide the bar to adjust the transparency of the stamp from 

the Transparency field. 

7. To set the text color of the stamp: Select the color from the list of colors displayed in 

the Text-Color. 

8. To set the font size of the text of the stamp: Select the size from the Font-Size drop 

down box field. 

9. To set the font family of the stamp: Select the font family from the Font-Face drop 

down box field. 

10. Click OK. 

Delete the Stamp 

Perform the following steps to delete any existing or predefined stamps: 

1. Click . 

2. The Stamp dialog box will appear. 

3. Select the stamp to delete from the list of available stamps. 

4. Click Delete. 

 You cannot delete all the stamps. There must be at least one stamp available in the list. 
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4.9 PolyLine 

The polyline annotation is a series of open, connected straight lines. User can perform the 

following steps to create a polyline annotation: 

1. On the Annotate tab, click PolyLine ( ). 

2. Move the pointer to the place to begin drawing. Click the left button to create the start 

point, move the pointer, and click to create each segment. 

3. To exit, double click the left mouse button. 

Edit Properties of PolyLine: 

1. Select and right click on the annotation. 

2. The Polyline Properties dialog box will appear. 

 

3. To set the color of the polyline: Select the color from the Color group in the 

Annotations tab. 

4. To set the width of the polyline: Select the width from the Border Width drop down 

box. 

5. To adjust the transparency: Slide the bar to adjust the transparency of the polyline from 

the Transparency. 

6. Click OK. 
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4.10 Polygon 

The polygon is a series of closed, connected straight lines with the last line connecting back to 

the first line to form a complete shape. The polygon can be filled with a color or be transparent. 

This tool gives you more control and flexibility in creating the desired annotation shape needed 

by the user. The user can perform the following steps to create a polygon annotation: 

1. On the Annotate tab, click Polygon ( ). 

2. Move the pointer to the place to begin drawing. Click the left button to create the start 

point, move the pointer, and click to create each segment. 

3. To exit, double click the left mouse button. 

Edit Properties of Polygon 

1. Select and right click on the annotation. 

2. The Polygon Properties dialog box will appear. 

 

3. To set the color of polygon: Select the color from the Color group in the Annotations 

tab. 

4. To set the width of the polygon: Select the width from the Border Width drop down 

box. 

5. To fill color inside polygon: Select the color from the list of colors displayed in the 

Background-Color. 

6. To adjust the transparency: Slide the bar to adjust the transparency of the polygon from 

the Transparency. 

7. Click OK. 
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4.11 Arc 

The arc annotation tool draws an arc with the following available adjustments: color and 

thickness. The user can perform the following steps to create an arc annotation: 

1. On the Annotate tab, click Arc ( ). 

2. Move the pointer to the place to begin, and then drag the mouse; create an angle by 

joining two lines at a vertex. 

3. To exit, double click the left mouse button.  

Edit Properties of Arc 

1. Select and right click on the annotation. 

2. The Arc Properties dialog box will appear. 

 

3. To set the color of an arc:  Select the color from the Color group in the Annotations tab. 

4. To set the width of an arc: Select the width from the Border Width drop down box. 

5. To adjust the transparency: Slide the bar to adjust the transparency of an arc from the 

Transparency. 

6. Click OK. 
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4.12 Angle 

The angle annotation tool easily and quickly measures the angle of the image to the nearest 

degree with the following available adjustments: color and thickness. It consists of two simple 

lines joined at a vertex to create an angle. The user can perform the following steps to create 

an angle annotation: 

1. On the Annotate tab, click Angle ( ). 

2. Move the pointer to the place to begin, and then drag the mouse; create an angle by 

joining two lines at a vertex. 

3. To exit, double click the left mouse button. 

Edit Properties of Angle 

1. Select and right click on the annotation. 

2. The Angle Properties dialog box will appear. 

 

3. To set the color of an angle: Select the color from the Color group in the Annotations 

tab. 

4. To set the width of an angle: Select the width from the Border Width drop down box. 

5. To adjust the transparency: Slide the bar to adjust the transparency of an angle from 

the Transparency. 

6. Click OK. 
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4.13 Ruler 

The ruler annotation tool draws a line that is used to measure the distance between two points 

of the image with adjustments: color and thickness. The user can perform the following steps to 

create the ruler annotation: 

1. On the Annotate tab, click Ruler ( ). 

2. Move the pointer to the place to begin, and then drag the mouse to the place where it 

should end, and release the mouse button. 

Edit Properties of Ruler 

1. Select and right click on the annotation. 

2. The Ruler Properties dialog box will appear. 

 

3. To set the color of the ruler: Select the color from the Color group in the Annotations 

tab. 

4. To set the width of the ruler: Select the width from the Border Width drop down box. 

5. To adjust the transparency: Slide the bar to adjust the transparency of the ruler from 

the Transparency. 

6. Click OK. 
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4.14 Cross Product 

The cross product annotation tool draws “x” to measure the distance horizontally and vertically 

between two points of the image with the following available adjustments: color and thickness. 

The user can perform the following steps to create the cross product annotation: 

1. On the Annotate tab, click Cross Product (  ). 

2. Move the pointer to the place to begin, and then drag the mouse to the place where it 

should end, and release the mouse button. 

Edit Properties of Cross Product 

1. Select and right click on the annotation. 

2. The Cross Product Properties dialog box will appear. 

 

3. To set the color of the Cross Product: Select the color from the Color group in the 

Annotations tab.  

4. To set the width of the Cross Product: Select the width from the Border Width drop 

down box. 

5. To adjust the transparency: Slide the bar to adjust the transparency of the cross 

product from the Transparency. 

6. Click OK. 

4.15  Scratch Out 

The scratch out annotation tool draws zigzag lines with the following available adjustments: 

color and thickness. The user can perform the following steps to create the stretch out 

annotation: 

1. On the Annotate tab, click Scratch Out ( ). 

2. Move the pointer to the place to begin, and then drag the mouse to the place where it 

should end, and release the mouse button. 
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Edit Properties of Scratch Out 

1. Select and right click on the annotation. 

2. The Scratch Out Properties dialog box will appear. 

 

3. To set the color of the Scratch Out: Select the color from the Color group in the 

Annotations tab. 

4. To set the width of the Scratch Out: Select the desired width from the Border Width 

drop down box. 

5. To adjust the transparency: Slide the bar to adjust the transparency of the Scratch Out 

from the Transparency. 

6. Click OK. 

4.16 Cloud 

The cloud annotation tool draws cloud with a series of connected lines with adjustments: color 

and thickness. The user can perform the following steps to draw the cloud annotation: 

1. On the Annotate tab, click Cloud ( ). 

2. Move the pointer to the place to begin, and then drag the mouse to the place where it 

should end, and release the mouse button. 

Edit Properties of Cloud 

1. Select and right click on the annotation. 

2. The Cloud Properties dialog box will appear. 
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3. To set the color of the Cloud: Select the color from the Color group in the Annotations 

tab. 

4. To set the width of the Cloud: Select the width from the Border Width drop down box. 

5. To adjust the transparency: Slide the bar to adjust the transparency of the cloud from 

the Transparency. 

6. Click OK. 

4.17 Strikeout and Highlighter 

eViewer provides two commenting tools, strike out and highlight, designed for different 

commenting tasks. Most comments include two parts: the markup or icon that appears on the 

page, and a text message that appears in a pop-up note when you select the comment. 

Strikeout:  The ability to cross out words. After you use this feature, the word remains, but a 

line is drawn horizontally through the midsection of the letters. Perform the following steps to 

strike out text in a document: 

1. On the Annotate tab, click Strikeout/Highlight ( ). 

2. Select the text to display with strikeout marks. To do this, place your cursor at the 

beginning of the text, hold down the left mouse button, drag the mouse across the word 

or sentence and then release the mouse button. 

3. The dialog box will appear. 

 

4. Type the comments in the comments text box area. 
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5. Click ( ) to change the color of the comment area. The color palette will appear. 

Select the color from the list of available colors. 

6. Select the tag for comments – correction, suggestion, fixed or important. 

o To provide the new tag to the comment, click New tag text box. 

 

 

 

 

o Clicking the box will bring the text box in an editable mode. 

o Provide the new tag name. 

o Click . 

o The new tag has been added in the tag list. 

7. Click Save. 

8. The comment is displayed at the right hand side of the viewer within the comment box. 

 

9. Click Edit to re-edit the comment. 

10. Click Reply to reply with your valuable feedback on the existing or reviewed comments. 

11. Click Delete to delete the comment. 

12. Click ( ) to minimize the comment box. 

13. The ( ) icon is displayed at the strike out text. 
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14. Click ( ) to read the strikeout comment. 

 

Highlight text: The user can perform the following steps to highlight text in a document. 

1. Select the text to display with the highlighted color. To do this, place the cursor at the 

beginning of the word, hold down your left mouse button, drag the mouse across the 

word or sentence and then release the mouse button. 

2. The box will appear. 
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3. Click ( ). 

4. The pop up window will appear.  

 

5. Click Highlight and select the color from the list of available colors to highlight text with 

the selected color.  

 If you do not select color, the text will be highlighted with the default selected color. 

6. Provide the comments in the comment area. 

7. Click ( ) to change the color of comment area. The color palette will appear. Select 

the required color from the list of available colors. 

8. Select the tag for the comments – correction, suggestion, fixed or important. 

 To provide new tag to the comments, click New tag text box. 

 

 Clicking the box will bring the text box in an editable mode. 

 Type the new tag name. 

 Click . 

 The new tag has been added in the tag list. 

9. Click Save. 

10. The comment has been highlighted in the page and is displayed in the right hand side of 

the viewer within a comment box. 
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11. Click Edit to re-edit the comment. 

12. Click Reply to reply with your valuable feedback on the reviewed comments. 

13. Click Delete to delete comment. 

14. Click ( ) to minimize comment box. 

15. The ( ) icon is displayed at the highlighted text. 

16. Click ( ) to read the comment of the highlighted text.  

 

4.18 Check Point 

The Check Point annotation is a great tool to assist users in reviewing and verifying forms. Users 

open the Check Point pane to quickly jump from area to area, verifying the information 

according to the instructions and mark each item as “Approved” or “Rejected”. The user can 

perform the following steps to add a checkpoint annotation on any specific area of the 

document: 

1. On the Annotate tab, click Check Point ( ) annotation tool. 

2. The pointer will change to tick mark. 

3. Move the pointer to the place to begin. Click and drag diagonally on the screen and 

release the mouse button. 

4. The comments dialog box will appear.  
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5. Type the comments for the checkpoint in the text box and click the Save.   

6. The CheckPoint dialog box will pop up from the right hand side with your comments and 

two buttons – Accept and Reject. 

 

7. The reviewer will review the comments and if agree, will ‘Accept’ the comments 

otherwise ‘Reject’. Upon Accepting, the status will change from unchecked to Approved 

and other requisite information such as Approver’s name with date and time will appear 

in the Information section. 
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8. On rejecting, the pop up will appear asking the reason of rejection. Type the reason in 

the provided text box and click OK. 

 

9. On Rejecting, the status will change from unchecked to Rejected and other requisite 

information such as Rejecters name with date and time and the reason of rejecting will 

appear in the Information section.   

 

 

4.19 SideNote 

The SideNote annotation enables reviewers to step through each Note annotation in the 

opened documents or images, review and add additional information and comments regarding 

an annotation, along with a complete audit trail of the comments. The user can perform the 

following steps to add a sidenote on any specific area of the document: 

1. On the Annotate tab, click SideNote ( ) annotation tool. 

2. Move the pointer to the place where you want the sidenote to begin. Click and drag 

diagonally on the screen and release the mouse button. 

3. The comments dialog box will appear.  
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4. Type the title name of the side note in Enter the Title. 

5. Type the comments in the comments area. 

6. Select the option from the list of available options in both the drop down boxes. 

7. Click Save. 

8. The SideNote dialog box will pop up from the right hand side with your comments and 

the selected options. 

 

9. Click Add Reply to reply the comments. 
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4.20 Launching eViewer from ICN IBM Content Navigator 

 

In ICN (IBM Content Navigator), the ‘Open Browse View’ contains various files and folders. 

The user can select document to meet the desired purpose in ‘eViewer’. It customizes user 

interface and offers usability enhancements for developers, administrators, and users alike. 

The viewer contains vivid fields like ‘Refresh’, ‘Add Document’, ‘New Folder’, and ‘Actions’ – 

to help user with editing and other related tasks.  
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Further to add, the user can select multiple files and get it uploaded in eViewer, all at the 

same time. The user can select desired number of files; by and by press the open button. 

This provides support of seamless viewing to the user. The phenomenon is clearly 

illustrated in the below placed figure, where three files are selected and ‘Open’ button is 

pressed to view the selected file in viewer at the same time.  

 

 

 

 

 

 

 

 

 

 

 

5. Annotation Text Search  

A quick and customized ‘annotation text search’ contributes immensely in delivering the 

efficient output. This is an advance search to harness, offerings of annotations that exists in one 

form or another.  Its major highlights include,  

 The user will find full text search capabilities with index based processing.  

 The user can instantly reach at annotation - containing selective text written in search 

button.  

The first step for user is to click at an icon of annotation text search. An icon is marked by arrow 

sign in the below placed figure.  
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Illustration:  

The vivid annotations are drawn with requisite text in the uploaded document – at 

eViewerHTML5. The user can easily search the text written in annotations by clicking the search 

icon, exclusively meant for annotations text searching.  

 

 

 

 

 

 

 

 

 

 



eViewer HTML5                                                                                                    

 
User Manual    
Document Version: 2.11                                                                                                               49 

 

Text searching  

There are vivid annotations drawn, available in eViewer HTML5 – where, user can easily find 

the text in annotation by using annotating text search. The click at icon will display the window 

of advance search containing features like ‘Whole words only’, ‘Case sensitive’, and ‘Annotation 

text search’ – to meet the user needs. Here, it is required from user side to click the checkbox 

with desired features to get the desired results. The phenomenon is figuratively illustrated 

underneath:  
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 In case, the user has clicked the checkbox of annotation text search - the corresponding 

results will be found. The output obtained is figuratively illustrated underneath. Here, 

you can see that three results are found with the provided user input (i.e., mohit). 

 

 In another case, user has selected all the three available features (i.e., Whole words 

only, Case-sensitive, and Annotation text search) – then, accordingly the corresponding 

results will be found. The explanation is figuratively illustrated underneath. Here, you 

can see that only one result is found with the provided user input (i.e., Susheel). 
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6. Adding Watermarks  

Watermarks are text or pictures that appear behind the document text. They often add interest 

or identify the document status, such as marking a document as a Draft, Confidential, and 

Urgent.  

eViewer provides a list of standard watermarks, or the user can create their own custom 

watermark, such as company logo. The user can perform the following steps to create a 

watermark: 

1. On the Annotate tab, click Add Watermark ( ). 

2. The Watermark dialog box will appear. 

 

3. Provide the details of the watermark corresponding to each field. 

4. Click OK. 

5. The watermark will be added on each page of the document. 
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7. Bookmarking Pages in a Document  

A user working with a large document needs to return to a specific location in the document for 

any purpose, Bookmark feature can prove invaluable. Rather than having to scroll through the 

pages of the document, user can quickly jump to the marked page with this feature. The user 

can perform the following steps to add bookmark: 

1. Go to the Thumbnail Window that lists all the pages of the document. If it is not open, 

go to the View tab, select Thumbnail check box. 

2. Hover mouse on the desired pages to place bookmark. 

3. The blue color icon ( ) will display at the top left corner of the page. 

4. Click ( ). 

5. The selected page has been bookmarked successfully. 

6. Repeat the above steps to add multiple bookmarks in the document. 

Edit/remove bookmark pages: 

Bookmarks can be edited/removed by one of the following ways: 

 Menu option 

 Thumbnail Window option 

Through Menu Option: 

1. On the Annotate tab, click Add Bookmark ( ). 

2. The Edit Bookmark dialog box listing bookmarked and unbook marked pages of the 

document will appear. 
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 The icon ( ) corresponding to the pages are bookmark pages. 

3. To remove bookmark from any specific page, click ( ) icon corresponding to that page. 

4. The ( ) icon will become ( ) signifies that bookmark has been removed successfully 

from the selected page. 

5. To add bookmark on the page, click ( ) icon corresponding to the page. The ( ) icon 

will become ( ) signifies that bookmark has been added successfully on the selected 

page.  

6. Click Update. 

 

Through Thumbnail Window: 

1. Go to the Thumbnail Window that lists all the pages of the document. If it is not open, 

go to the View tab, select Thumbnail checkbox. 

2. The pages marked with blue color icon ( ) are bookmark pages(s). 

3. To remove bookmark from the page, click ( ) icon corresponding to that page. 

4. The icon will disappear from the selected page, signifies that the bookmark has been 

removed successfully from the page. 
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8.   Search  

The user will get search functionality for bookmark and annotation. It also includes the feature of ‘Case-

Sensitive’ to give specified, precise and quick search.  

 8.1 Bookmarks  

It comprises of the following steps.  

Step 1: Upload the document  

Step 2: Select the text annotation to bookmark the text. It is highlighted with the arrow mark in the 

below placed figure.  
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Step 3: Draw the annotation and write the text (e.g., MST). It is highlighted with the arrow mark in the 

below placed figure.  

 

 

Step 4: Press the search button. It is highlighted with the arrow mark in the below placed figure.  
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Step 5: The output result will be as displayed below.  
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 8.2 Annotation  

The application supports four annotations (i.e., SideNote, Check Point, Strikeout/Highlight, and Stamp).  

1.1 SideNote annotation  

Step 1: Click at SideNote annotation. It is highlighted by arrow mark in the below placed figure.  

 

 

Step 2: Enter the comment in the form displayed and click at save button. This is figuratively illustrated 

underneath.  
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Step 3: Click at search button. It is highlighted by arrow mark in the below placed figure. 

 

 

Step 4: The output is obtained. Press the ‘OK’ button.  This is figuratively illustrated underneath.  
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1.2 Check Point 

Step 1: Click at ‘Check Point’ annotation. It is highlighted by arrow mark in the below placed figure.  

 

 

Step 2: Enter the comment in the form displayed and click at save button. This is figuratively illustrated 

underneath.  
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Step 3: Click at search button. It is highlighted by arrow mark in the below placed figure. 

 

 

Step 4: The output is obtained. Press the ‘OK’ button.  This is figuratively illustrated underneath.  
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1.3 Strikeout/Highlight 

Step 1: Click at ‘Strikeout/Highlight’ annotation. It is highlighted by arrow mark in the below placed 

figure.  

 

  

Step 2: Enter the comment in the form displayed and click at save button. This is figuratively illustrated 

underneath.  
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Step 3: Click at search button. It is highlighted by arrow mark in the below placed figure. 

 

 

Step 4: The output is obtained. Press the ‘OK’ button.  This is figuratively illustrated underneath.  
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1.4 Stamp Annotation 

 

Step 1: Click at ‘Stamp’ annotation. It is highlighted by arrow mark in the below placed figure.  

 

  

Step 2: The dialog box for stamp creation will appear on the screen; click at ‘New Stamp’. This is 

figuratively illustrated underneath. 
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Step 3: Write the desired text and put image in the field provided and press the ‘OK’ button. This is 

figuratively illustrated underneath. 

 

 

Step 4: The stamp preview of the text (e.g., the red rose) will appear. Click at ‘OK’ button. It is marked by 

arrow sign in the below placed figure.  
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Step 5: The newly created stamp (i.e., the red rose) is ready for the function and operation. The user can 

place images or text stamp anywhere on the document.  

 

 

Step 6: Click at search button. It is highlighted by arrow mark in the below placed figure. 
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Step 4: The output is obtained. Press the ‘OK’ button.  This is figuratively illustrated underneath.  
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Note: The search application contains the feature of ‘Case Sensitive’. This helps user in obtaining the 

specified search. It is highlighted by arrow mark in the below placed figure. 

 

 

Here, the output of the illustration is as follows: 
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 8.3 Hide the Blank Page  

The feature (Click Here to Hide Blank Page) will hide all the blank pages present in the uploaded 

document. For example, if the document contains nine pages and in which, three pages are blank. Now, 

only six pages will be displayed as output and the three blank pages will hide. It is highlighted with arrow 

mark in the below placed figure.  
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9.   Smart Redaction 

Several type of confidential information comes in the form of text patterns (Social Security 

numbers, account numbers, Date of Births, passport numbers, names) that needs to be 

removed from the documents. The eViewer provides a text pattern search capability that 

allows fast and easy identification of predefined text patterns in the documents and files. The 

Smart Redaction™ provides numerous powerful predefined text search pattern options to 

automatically find and highlight the matching searches and then redact them.  

Smart Redaction works on all file formats supported by the eViewer including: Word, Excel, 

PDF, and TIFF. Redacted files can be published in any formats including PDF, TIFF, and any other 

image format. In the published file, anything redacted is permanently removed and cannot be 

found in a search and can't be copied. 

Perform the following steps to redact any specific text pattern in the document: 

1. On the Redact tab, select the category to redact text from the list of existing categories. 

2. Click ( ). 

3. The matched text based on the selected category will get highlighted in the document. 

4. To search the specific pattern of text, type the text in the text box, select the option as 

per the need - Case sensitive and Whole word and click ( ). 

 Case Sensitive: If selected, searches only for words that match the case of the word or 

phrase that has been typed in the text box. This means that the search becomes case-

sensitive. For example, if you search menu, the result includes all instances of menu 

with this exact spelling but not Menu or MENU. 

 

 Whole Word: If selected, restricts the search to whole words only. Whole words are 

words separated, on both sides, by a space. For example, if you search for edit, the 

result includes instances of edit only not editing, editor, editorial, and edited. 

 

 To redact the text, click ( ) and drag over the text. 

5. The solid rectangle will display over the redacted text. 

6. To change the color of redaction, click (  ). The color palette appears. Select the 

color. 
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10.   Shortcut Keys  

                                                    Home Menu 

 

 

 

Feature Shortcut key 

First Page Shift+Home 

Previous page Alt+Pageup 

Next page Alt+Pagedown 

Last Page Shift+End 

First Bookmark Ctrl+Alt+< 

Previous Bookmark Ctrl+Shift+< 

Next Bookmark Ctrl+Shift+> 

Last Bookmark Ctrl+Alt+> 

Zoom In  Shift++/ Shift+= 

Zoom Out  Shift+-(dash)/ Shift+- 

RubberBand Zoom Shift+M 

Rotate 90 ClockWise Ctrl+Arrow Right 

Rotate 90 Anti-ClockWise Ctrl+Arrow Left 

Cut Page Alt+Delete 

Delete Page Shift+Delete 

Copy Page Shift+C 

Paste Page Shift+V 

Search Shift+F 

Search+Match Case Ctrl+Shift+F 

Previous Search Shift+Enter 

Next Search Enter 

Advance Search Shift+A 

Advance Search +Whole Word Only Ctrl+Shift+A 
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View Menu 

Feature Shortcut key 

Reset Shift+Z 

Actual Size Shift+1 

Fit to window Shift+3 

Fit to width Shift+2 

Fit to height Shift+0 

Invert Ctrl+Alt+I 

Flip Vertical Ctrl+ Shift +V 

Flip Horizontal Shift+H 

Enhance Shift+E 

Grey Scale Alt+G 

Thumbnails Ctrl+Shift +B 

TreeView Shift +T  

PDF Outline Shift +O 

Create BookMark Ctrl+B  
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Annotation Menu 

Feature Shortcut key 

Color Ctrl+Alt+K 

Normal Ctrl+Alt+Z 

Line Ctrl+Alt+L 

Rectangle Ctrl+Alt+R 

Circle Ctrl+Alt+C 

Arrow   Ctrl+Alt+O 

Pen Ctrl+Alt+P  

Highlighter Ctrl+Alt+H 

Text Ctrl+Alt+T 

Stamp Ctrl+Alt+S 

PolyLine Ctrl+Shift+Y 

Polygon Ctrl+Alt+N  

Scratch-Out Ctrl+Shift+S 

Cloud Ctrl+Alt+D 

Cross Product Ctrl+Alt+X 

Arc CTRL+SHIFT+K 

Angle Ctrl+Alt+E 

Ruler Alt+Shift+R 

SideNote Alt+S 

Check Point Ctrl+Shift+E  

Strikeout/Highlight Shift+L 

Add Watermark Ctrl+Alt+W  

Add Bookmark Shift+B 

Delete Annotation Delete 

Show/Hide Annotation Ctrl+M 
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Redaction Menu 

Feature Shortcut key 

Advance Redaction Alt+P 

Redact Option Alt+Y 

Redact Option+Whole Word Ctrl+Alt+Y 

Redact Option+Case Sensitive Shift+Alt+Y 

Search & Redact Enter 

Previous Search Alt+< 

Next Search Alt+> 

Reset Redaction Ctrl+Z 

Redact Selected Area Shift+Alt+Delete 

 

File Menu 

Feature Shortcut key 

Edit Ctrl+F2 

Save Shift+S 

Print Shift+P 

Comments Ctrl+/ 

Viewer Info Shift+I 

Version Number Alt+I 

 

Annotation Drawing 

Feature Shortcut key 

Draw Annotation Ctrl+Enter 

Resize +ve X Shift+Arrow Right 

Resize -ve X Shift+Arrow Left 

Resize +ve Y Shift+W 

Resize -ve Y Shift+X 

Move +ve X Alt+Arrow Right 

Move -ve X Shift +< 

Move +ve Y Alt+W 

Move -ve Y Shift+J 

Properties Shift+Enter 
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	1. Getting Started
	This section lets you get acquainted with various sections covered in this user manual which further helps you in understanding the product, eViewer HTML5 in a better way. You can also understand the purpose of developing such product. This user guide...
	1.1 Brief about User Guide

	Welcome to the user guide of eViewer HTML5 which is proficient, competent and result-oriented product. This user guide has been designed for users to understand the software in an efficient and effective manner. So we recommend you to carefully go thr...
	1.2 Overview

	eViewer HTML5 is a very powerful, yet hassle-free, Zero Footprint viewer for viewing multiple formats including TIFF, JPG, PDF, MO:DCA and many others. It is a high-performance document viewing solution that enables users to view documents and images ...
	1.3 Features

	eViewer HTML5 is loaded with rich features that make it complete and outstanding. Some of the features are listed below:
	 Documents and images are directly retrieved and viewed through browsers.
	 Hassle-Free Integration: No workstation installation or platform compatibility issues due to the use of Java, AJAX, and HTML5 technologies.
	 File Support: Supports most of the file formats as supported by our flagship viewer, MST Viewer.
	 Annotation support: Including PDF and MO:DCA annotations.
	 File Conversion: Automatically converts files temporarily into an image format to display in an internet browser. Also, provides an option to save the converted file to PDF, TIFF, JPEG, GIF, BMP, or back to the original format.
	 Image Processing: Performed on the server to deliver an extremely high-speed response.
	 Easy Navigation: Go directly to any page on the document.
	 Printing: Print single and multi-page documents with or without annotations.
	1.4 Benefits

	eViewer HTML5 provides a number of benefits including:
	 Reduce Overhead and Increase Productivity: Allows companies to reduce a number of applications to one efficient universal document and image viewer.
	 Zero Footprint HTML5 Viewer: Compatible with up-to-date internet browsers with zero client-side installation needed.
	 Annotations: Access to a number of different annotations including, but not limited to redaction, line, arrow, rectangle, circle, text, highlighter, pen, and stamps.
	 Internal Development: All file formats are developed by in-house MST developers and do not use any third party APIs. This gives you the ability to have customization, prompt resolutions to issues, and release control.
	1.5 Supported File Formats

	eViewer HTML5 supports following file formats:
	IBM proprietary file formats
	 MO:DCA (Mixed Object: Document Content Architecture)
	 IOCA (Image Object Content Architecture)
	 PTK (PTOCA)
	Office file formats
	 DOC (Microsoft Word Document)
	 DOCX (Microsoft Word Document 2007 and above)
	 XLS (Microsoft Excel Spreadsheet)
	 XLSX (Microsoft Excel Spreadsheet 2007 and above)
	 PPT (PowerPoint Presentation)
	 PPTX (PowerPoint Presentation 2007 and above)
	 VSD (Microsoft Visio)
	Documents
	 PDF (Adobe Portable Document)
	 RTF (Rich Text)
	 TXT (ASCII Text)
	Image file formats
	 ABIC
	 BMP (Windows and OS/2 Bitmap Formats)
	 CAL (CALS Raster)
	 DCX (Paint Brush)
	 DCM (DICOM)
	 EMF (Windows Metafile)
	 GIF(CompuServe GIF)
	 JBG (JBIG)
	 JB2 (JBIG2)
	 JPG(Joint Photographic Experts Group (JPEG))
	 JPEG-XR (Windows Media Photo / HD Photo (HDP))
	 JPEG-LS (JPEG Lossless)
	 J2K (JPEG 2000)
	 JP2 (JPEG 2000 Compressed)
	 JPM (JPEG 2000 Part 6)
	 JPX (JPEG 2000 Part 2)
	 PNG (Portable Network Graphics)
	 PNM (Portable aNy Map)
	 PPM (Portable PixMap)
	 PBM (Portable Bitmap Utilities)
	 PCX (Paint Brush)
	 RAS (SUN Raster)
	 TIFF (Tagged Image File)
	 WBMP (Wireless Bitmap)
	 WMF (Windows Metafile)
	 XPM (XPicMap)
	2. Understanding User Interface (UI)
	eViewer HTML5 has a very user friendly and intuitive user interface that provide quick access to all important functions the user needs.
	2.1 The Ribbon

	Ribbon combines the menu bar and toolbar into a single floating pane. The purpose of the ribbon is to bring the most popular commands to the forefront, so you don’t have to search for the most common commands in the viewer.
	Additionally, the ribbon includes several tabs that are used to reveal different groups of commands. Since the ribbon contains both the program's menu options and toolbar commands, it cannot be removed from the screen.
	The Ribbon offers ease of use and convenience, with all common actions shown at one place.  The Ribbon has three parts – tabs, groups, and commands.
	Tabs
	The Ribbon has four basic tabs across the top with each tab representing an activity area with their own specified commands.
	By default, the Home tab is displayed when the viewer is opened.
	Groups
	Commands are sectioned into groups within each tab.
	Commands
	A Command is a button or a box or a menu where you enter information. Commands are organized in logical groups that are collected together under tabs.
	For example, in the above group Zoom,  (), (), () are zoom commands.
	2.2 Toolbars and Tabs

	eViewer HTML5 has four tabs that allow modifying any type of file. Each tab has separate groups with specified commands performing their particular task.
	Home Tab
	This is the standard view tab that is comprised of the following groups: Page Navigation, Zooming, Rotation, Clipboard, and editing.
	View Tab
	This tab allows to change the view of the document that is comprised of the following groups: image scaling, image processing functions, window modification, and other viewing tools.
	Annotation Tab
	This tab contains the annotation tools available with the viewer with additional features - adding bookmarks and watermark.
	Redact Tab
	This tab contains redaction functions available in the viewer including the groups for text search, redaction reason, and redaction option.
	3. Common Tasks
	This section lists the operations that can be performed by the eViewer document viewer.
	3.1 Opening Documents

	Documents can be opened in eViewer from the following ECMs:
	 From Microsoft SharePoint
	 From IBM FileNet P8
	 From IBM Content Manager 8
	 From EMC Documentum WebTop
	 From another CMIS ECM system
	Opening Documents from Microsoft SharePoint
	Perform the following steps to open a document from the SharePoint repository:
	1. Open an Internet browser and enter in the SharePoint URL.
	2. The login page appears.
	3. Provide the user name and password.
	4. After successfully logging in, the SharePoint Libraries and Lists will be displayed on the left side of the screen.
	5. Click on the library from the list of libraries, displayed in the Libraries group.
	6. The list of folders and documents exist in the selected library are populated on the right side of the screen.
	7. Perform one of the following:
	 For documents listed in library: Hover the mouse over the document that you want to view in the eViewer. A checkbox will appear at the beginning corresponding to the document. Select the checkbox and click eViewer HTML5 icon displayed on the ribbon....
	 For folders listed in library: Double click on the folder. The list of document exist in the folder were populated on the screen. Hover mouse over the document that you want to view in the viewer. A checkbox will appear at the beginning correspondin...
	Opening Documents from FileNet P8
	Perform the following steps to open a document from FileNet P8 repository:
	1. Open the browser and enter the FileNet P8 URL.
	2. The login page appears.
	3. Provide the user name and password.
	4. The FileNet object stores page appears.
	5. Select the object stores from the existing list.
	6. The list of folders exists in the object stores were populated on the screen.
	7. Click on the folder whose documents that you want to view in the viewer.
	8. The list of documents exist in the selected folder were displayed on the screen.
	9. Right click on the document that you want to view in the viewer and select Open in MST viewer.
	10. The selected document will be opened in the viewer in a separate window.
	Opening Documents from IBM Content Manager 8
	Please contact us to assist you with the integration with Content Manager 8.
	Opening Documents from EMC Documentum WebTop
	Please contact us to assist you with the integration with EMC’s Documentum for WebTop.
	Opening Documents from another CMIS ECM System
	Please review the developer’s guide on the available exposed APIs for connecting to other applications.
	3.2 Saving Documents

	To save the document, click Save () displayed at the upper right corner of the viewer.
	3.3 Printing Documents

	The document can be printed by performing the following steps:
	1. Click ().
	2. The Print Document dialog box will appear.
	3. Provide the range of page numbers to print in From Page and To Page respectively.
	4. Select or clear Print Annotation checkbox to print or not to print annotations made on the page.
	5. Select or clear Print Strike Out checkbox to allow strikeout comments to be print or not to print on the page.
	6. Select or clear Print Highlight checkbox to allow highlighted text to be print or not to print on the page.
	7. Click OK.
	8. The Print dialog box appears.
	9. Under Printer group, select the printer to use (if it is not selected).
	10. Under Copies group, select the number of copies to print
	3.4 Thumbnail Window

	The Thumbnail Window displays a miniature representation of the document pages that allows easily navigating multi-page documents. Perform the following steps to view thumbnail view of a document:
	1. On the View tab, select Thumbnails check box.
	2. The Thumbnail Window will display at the left side of the viewer.
	The document can be viewed in the document view area of the viewer by scrolling the bar of the thumbnail window. Click on the thumbnail image (page) and the selected thumbnail will get open in the right side, that is, in the document viewer area of th...
	The sequence of the pages of the document can be changed in the thumbnail window. The most convenient way to move or copy a page of the document is to select and drag it to the desired location on the document. The same works here. Just hold the mouse...
	3.5 Zooming Text/Image in a Document

	Zoom is a feature that either increases or decreases the size of a page or the size of all the text displayed in a page (Text Zoom) in order to improve readability. You can zoom in to get a close-up view of the file/document or zoom out to see page at...
	1. On the Home tab, click () to increase the magnification percentage of the page.
	2. On the Home tab, click () to decrease the magnification percentage of the page.
	Rubber Band Zoom
	Another type of zoom that eViewer HTML5 provides is the Rubber Band Zoom that magnifies the selected image or text area in order to improve the readability of the image or text. Perform the following steps to perform rubber band zoom on the text or im...
	1. On the Home tab, click the Rubber Band Zoom ().
	2. Select an area on the page. For this, hold down the left mouse button and drag the mouse pointer diagonally.
	3. A box forms between the starting and ending positions of the mouse pointer.
	4. Release the left mouse button when the area has been defined.
	5. The rubber-banded magnified area will display in the center of the screen.
	3.6 Searching Text in a Document

	The eViewer provides text search functionality to enable users to quickly find text information in a document. Perform the following steps to search text in a document.
	1. On the Home tab, type the text to search in Search Text box.
	2. Press Enter.
	3. If the result is found, the searched text will be highlighted in the document.
	4. Click  arrows to go to the previous and next matched text.
	5. Select or clear Highlight All checkbox to display all the searched text found in the document.
	6. Select or clear Match Case checkbox to search only for words that match the case of the word or phrase that has been typed in the text box. This means that the search becomes case-sensitive. For example, if you search menu, the result includes all ...
	7. Click Advanced Search () to search the text with other advanced search options.
	8. The Advanced Search dialog box will appear.
	9. Type the text to search and select the option as per your need.
	 Case-Sensitive: If selected, searches only for words that match the case of the word or phrase that has been typed in the text box. This means that the search becomes case-sensitive. For example, if you search menu, the result includes all instances...
	 Whole words only: If selected, restricts the search to whole words only. Whole words are words separated, on both sides, by a space. For example, if you search for edit, the result includes instances of edit only not editing, editor, editorial, and ...
	10. Click Search.
	11. All the matched text will display in the window.
	12. Click on the desired matched text.
	13. The application will bring to the page on which the match was found.
	4. Annotations
	Annotations are comments, notes, markups, explanations, or other types of external remarks that can be added to a selected part of the document to point out, explain or illustrate an area or item on the document.
	eViewer provides tools to enable users to freely write their comments, sticky notes and add markups on documents to help with collaborating with others. Additionally it provides the ability to add digital stamps, and other markups to make the eViewer ...
	Annotation marks are saved as annotation data that is stored on a separate file and not on the original document. Whenever a user makes an annotation, a file with the same name as the document with an extension .xml is created in the current directory...
	The following are the available annotations that are provided by the eViewer:
	4.1 Line

	The Line annotation tool provides the user with the ability to draw a horizontal, vertical, or lines at 45  with the following adjustments: color, thickness, and transparency. The user can perform the following steps to create a line annotation:
	1. On the Annotate tab, click Line ().
	2. Click where the line to begin, and then drag the mouse to the place where it should end, and release the mouse button.
	Edit Properties of Line
	1. Select and right click on the annotation.
	2. The Line Properties dialog box will appear.
	3. To set the color of the line: Select the color displayed from the Color group in the Annotations tab.
	4. To set the width of the line: Select the width from the Border Width drop down box.
	5. To adjust the transparency of the line: Slide the bar to adjust the transparency of the line from Transparency field.
	6. Click OK.
	4.2 Rectangle

	The rectangle annotation tool draws a rectangle with the following available adjustments: line and fill color, thickness, and transparency. The user can perform the following steps to create a rectangle annotation:
	1. On the Annotate tab, click Rectangle ().
	2. Click and drag diagonally on the screen and release the mouse button.
	Edit Properties of Rectangle
	1. Select and right click on the annotation.
	2. The Rectangle Properties dialog box will appear.
	3. To set the color of the border of the rectangle: Select the color from the Color group in the Annotations tab.
	4. To set the width of the rectangle: Select the width from the Border Width drop down box.
	5. To fill color inside the rectangle: Select the color from the list of colors displayed in the Background-Color.
	6. To adjust the transparency of the rectangle: Slide the bar to adjust the transparency of the rectangle from Transparency field.
	7. Click OK.
	4.3 Circle

	The circle annotation tool draws a circle with the following adjustments: line and fill color, thickness, and transparency. The user can perform the following steps to create a circle annotation:
	1. On the Annotate tab, click Circle ().
	2. Click and drag diagonally on the screen and release the mouse button.
	Edit Properties of Circle
	1. Select and right click on the annotation.
	2. The Circle Properties of dialog box will appear.
	3. To set the color of the border of the circle: Select the color from the Color group in the Annotations tab.
	4. To set the width of the circle: Select the width from the Border Width drop down box.
	5. To fill color inside the circle: Select the color from the list of colors displayed in the Background-Color.
	6. To adjust the transparency of the circle: Slide the bar to adjust the transparency of the circle from Transparency field.
	7. Click OK.
	4.4 Arrow

	The arrow annotation tool draws a horizontal, vertical or 45  arrow with the following adjustments: color, thickness, and transparency. The user can perform the following steps to create an arrow annotation:
	1. On the Annotate tab, click Arrow ().
	2. Click and drag diagonally on the screen and release the mouse button.
	Edit Properties of Arrow
	1. Select and right click on the annotation.
	2. The Arrow Properties dialog box will appear.
	3. To set the color of an arrow: Select the color from the Color group in the Annotation tab.
	4. To set the width of an arrow: Select the width from the Border Width drop down box.
	5. To adjust the transparency: Slide the bar to adjust the transparency of an arrow from the Transparency field.
	6. Click OK.
	4.5 Highlighter

	The highlighter annotation tool provides the user with the ability to provide highlight markups with the viewer. The user can perform the following steps to create a highlight annotation:
	1. On the Annotate tab, click Highlighter ().
	2. Click and drag diagonally on the screen and release the mouse button.
	Edit Properties of Highlighter
	1. Select and right click on the annotation.
	2. The Highlighter Properties dialog box will appear.
	3. To fill color inside the highlighter: Select the color from the list of colors displayed in the Background-Color.
	4. To adjust the transparency: Slide the bar to adjust the transparency of the highlighter from the Transparency field.
	5. Click OK.
	4.6 Pen

	The pen annotation tool draws freehand lines and shapes with the following available adjustments: color, thickness, and transparency. The user can perform the following steps to create a freehand line annotation:
	1. On the Annotate tab, click Pen ().
	2. Click on the screen and drag the mouse. The mouse will follow your moves. Release the mouse button to end your drawing.
	Edit Properties of Pen
	1. Select and right click on the annotation.
	2. The Pen Properties dialog box will appear.
	3. To set the color of the freehand line: Select the color from the Color group in the Annotation tab.
	4. To set the width of the freehand line: Select the desired width from the Border Width drop down box.
	5. To adjust the transparency: Slide the bar to adjust the transparency of the freehand line from the Transparency field.
	6. Click OK.
	4.7   Text

	The text annotation tool enters text on a page with the following available adjustments: size and color of the font and the text box. The user can perform the following steps to create and place any text annotation:
	1. On the Annotate tab, click Text ().
	2. Click and drag diagonally on the screen and release the mouse button.
	3. Double click on the text box to type text in the box.
	4. A cursor will appear on the screen allowing you to type in text.
	5. To finish editing text, click anywhere outside the text box.
	6. To edit the text later, double click on the text.
	7. The text box can be repositioned by dragging the text box border and the size of the text box can be adjusted by dragging the selection handles.
	Edit Properties of Text
	1. Select and right click on the annotation.
	2. The Text Properties dialog box will appear.
	3. To set the border color of the text box: Select the color from the Color group in the Annotations tab.
	4. To set the width of the text box: Select the width from the Border Width drop down box.
	5. To fill color inside the text box: Select the color from the list of colors displayed in the Background-Color.
	6. To adjust the transparency: Slide the bar to adjust the transparency of the box from the Transparency.
	7. To set the color of the text: Select the color from the list of colors displayed in the Text Color.
	8. To set the font size of the text: Select the size from Font-Size drop down box field.
	9. To set the font family of the text: Select the font family from Text Font Face drop down box field.
	10. Click OK.
	4.8 Stamp

	This tool allows adding wide variety of readymade or custom made stamps on the document. You can place images and/or text stamps anywhere on the document. The user can choose either from a list of predefined stamps or create their own stamps. The user...
	1. On the Annotate tab, click Stamp ().
	2. Select the stamp from the list of available stamps.
	Create New Stamp
	All the existing stamps are located in the list of predefined stamps. To create a new stamp, perform the following steps:
	1. Click  .
	2. The Stamp dialog box will appear.
	3. Click New Stamp
	4. Under Stamp Properties group, for the new stamp, select the border and text color, thickness and transparency in the Background-Color and Text-Color, Border-Width and Transparency fields respectively.
	5. Under Text/Image group, select from the available options the type of new stamp either Text or Image. For Text stamp, type the name of the stamp in the text box. For Image stamp, click   and explore the image to display. Click OK.
	6. The newly created stamp will be listed in the Total Stamp(s) list box.
	7. The preview of the newly created stamp will display in the Stamp Preview group.
	8. Click OK.
	Edit Properties of Stamp
	1. Select and right click on the stamp.
	2. The Stamp Text dialog box will appear.
	3. To set the border color of the stamp: Select the color from the Color group in the Annotations tab.
	4. To set the width of the stamp: Select the width from the Border Width drop down box.
	5. To fill color inside the stamp: Select the color from the list of colors displayed in the Background-Color.
	6. To adjust the transparency: Slide the bar to adjust the transparency of the stamp from the Transparency field.
	7. To set the text color of the stamp: Select the color from the list of colors displayed in the Text-Color.
	8. To set the font size of the text of the stamp: Select the size from the Font-Size drop down box field.
	9. To set the font family of the stamp: Select the font family from the Font-Face drop down box field.
	10. Click OK.
	Delete the Stamp
	Perform the following steps to delete any existing or predefined stamps:
	1. Click .
	2. The Stamp dialog box will appear.
	3. Select the stamp to delete from the list of available stamps.
	4. Click Delete.
	 You cannot delete all the stamps. There must be at least one stamp available in the list.
	4.9 PolyLine

	The polyline annotation is a series of open, connected straight lines. User can perform the following steps to create a polyline annotation:
	1. On the Annotate tab, click PolyLine ().
	2. Move the pointer to the place to begin drawing. Click the left button to create the start point, move the pointer, and click to create each segment.
	3. To exit, double click the left mouse button.
	Edit Properties of PolyLine:
	1. Select and right click on the annotation.
	2. The Polyline Properties dialog box will appear.
	3. To set the color of the polyline: Select the color from the Color group in the Annotations tab.
	4. To set the width of the polyline: Select the width from the Border Width drop down box.
	5. To adjust the transparency: Slide the bar to adjust the transparency of the polyline from the Transparency.
	6. Click OK.
	4.10 Polygon

	The polygon is a series of closed, connected straight lines with the last line connecting back to the first line to form a complete shape. The polygon can be filled with a color or be transparent. This tool gives you more control and flexibility in cr...
	1. On the Annotate tab, click Polygon ().
	2. Move the pointer to the place to begin drawing. Click the left button to create the start point, move the pointer, and click to create each segment.
	3. To exit, double click the left mouse button.
	Edit Properties of Polygon
	1. Select and right click on the annotation.
	2. The Polygon Properties dialog box will appear.
	3. To set the color of polygon: Select the color from the Color group in the Annotations tab.
	4. To set the width of the polygon: Select the width from the Border Width drop down box.
	5. To fill color inside polygon: Select the color from the list of colors displayed in the Background-Color.
	6. To adjust the transparency: Slide the bar to adjust the transparency of the polygon from the Transparency.
	7. Click OK.
	4.11 Arc

	The arc annotation tool draws an arc with the following available adjustments: color and thickness. The user can perform the following steps to create an arc annotation:
	1. On the Annotate tab, click Arc ().
	2. Move the pointer to the place to begin, and then drag the mouse; create an angle by joining two lines at a vertex.
	3. To exit, double click the left mouse button.
	Edit Properties of Arc
	1. Select and right click on the annotation.
	2. The Arc Properties dialog box will appear.
	3. To set the color of an arc:  Select the color from the Color group in the Annotations tab.
	4. To set the width of an arc: Select the width from the Border Width drop down box.
	5. To adjust the transparency: Slide the bar to adjust the transparency of an arc from the Transparency.
	6. Click OK.
	4.12 Angle

	The angle annotation tool easily and quickly measures the angle of the image to the nearest degree with the following available adjustments: color and thickness. It consists of two simple lines joined at a vertex to create an angle. The user can perfo...
	1. On the Annotate tab, click Angle ().
	2. Move the pointer to the place to begin, and then drag the mouse; create an angle by joining two lines at a vertex.
	3. To exit, double click the left mouse button.
	Edit Properties of Angle
	1. Select and right click on the annotation.
	2. The Angle Properties dialog box will appear.
	3. To set the color of an angle: Select the color from the Color group in the Annotations tab.
	4. To set the width of an angle: Select the width from the Border Width drop down box.
	5. To adjust the transparency: Slide the bar to adjust the transparency of an angle from the Transparency.
	6. Click OK.
	4.13 Ruler

	The ruler annotation tool draws a line that is used to measure the distance between two points of the image with adjustments: color and thickness. The user can perform the following steps to create the ruler annotation:
	1. On the Annotate tab, click Ruler ().
	2. Move the pointer to the place to begin, and then drag the mouse to the place where it should end, and release the mouse button.
	Edit Properties of Ruler
	1. Select and right click on the annotation.
	2. The Ruler Properties dialog box will appear.
	3. To set the color of the ruler: Select the color from the Color group in the Annotations tab.
	4. To set the width of the ruler: Select the width from the Border Width drop down box.
	5. To adjust the transparency: Slide the bar to adjust the transparency of the ruler from the Transparency.
	6. Click OK.
	4.14 Cross Product

	The cross product annotation tool draws “x” to measure the distance horizontally and vertically between two points of the image with the following available adjustments: color and thickness. The user can perform the following steps to create the cross...
	1. On the Annotate tab, click Cross Product ( ).
	2. Move the pointer to the place to begin, and then drag the mouse to the place where it should end, and release the mouse button.
	Edit Properties of Cross Product
	1. Select and right click on the annotation.
	2. The Cross Product Properties dialog box will appear.
	3. To set the color of the Cross Product: Select the color from the Color group in the Annotations tab.
	4. To set the width of the Cross Product: Select the width from the Border Width drop down box.
	5. To adjust the transparency: Slide the bar to adjust the transparency of the cross product from the Transparency.
	6. Click OK.
	4.15  Scratch Out

	The scratch out annotation tool draws zigzag lines with the following available adjustments: color and thickness. The user can perform the following steps to create the stretch out annotation:
	1. On the Annotate tab, click Scratch Out ().
	2. Move the pointer to the place to begin, and then drag the mouse to the place where it should end, and release the mouse button.
	Edit Properties of Scratch Out
	1. Select and right click on the annotation.
	2. The Scratch Out Properties dialog box will appear.
	3. To set the color of the Scratch Out: Select the color from the Color group in the Annotations tab.
	4. To set the width of the Scratch Out: Select the desired width from the Border Width drop down box.
	5. To adjust the transparency: Slide the bar to adjust the transparency of the Scratch Out from the Transparency.
	6. Click OK.
	4.16 Cloud

	The cloud annotation tool draws cloud with a series of connected lines with adjustments: color and thickness. The user can perform the following steps to draw the cloud annotation:
	1. On the Annotate tab, click Cloud ().
	2. Move the pointer to the place to begin, and then drag the mouse to the place where it should end, and release the mouse button.
	Edit Properties of Cloud
	1. Select and right click on the annotation.
	2. The Cloud Properties dialog box will appear.
	3. To set the color of the Cloud: Select the color from the Color group in the Annotations tab.
	4. To set the width of the Cloud: Select the width from the Border Width drop down box.
	5. To adjust the transparency: Slide the bar to adjust the transparency of the cloud from the Transparency.
	6. Click OK.
	4.17 Strikeout and Highlighter

	eViewer provides two commenting tools, strike out and highlight, designed for different commenting tasks. Most comments include two parts: the markup or icon that appears on the page, and a text message that appears in a pop-up note when you select th...
	Strikeout:  The ability to cross out words. After you use this feature, the word remains, but a line is drawn horizontally through the midsection of the letters. Perform the following steps to strike out text in a document:
	1. On the Annotate tab, click Strikeout/Highlight ().
	2. Select the text to display with strikeout marks. To do this, place your cursor at the beginning of the text, hold down the left mouse button, drag the mouse across the word or sentence and then release the mouse button.
	3. The dialog box will appear.
	4. Type the comments in the comments text box area.
	5. Click () to change the color of the comment area. The color palette will appear. Select the color from the list of available colors.
	6. Select the tag for comments – correction, suggestion, fixed or important.
	o To provide the new tag to the comment, click New tag text box.
	o Clicking the box will bring the text box in an editable mode.
	o Provide the new tag name.
	o Click.
	o The new tag has been added in the tag list.
	7. Click Save.
	8. The comment is displayed at the right hand side of the viewer within the comment box.
	9. Click Edit to re-edit the comment.
	10. Click Reply to reply with your valuable feedback on the existing or reviewed comments.
	11. Click Delete to delete the comment.
	12. Click () to minimize the comment box.
	13. The () icon is displayed at the strike out text.
	14. Click () to read the strikeout comment.
	Highlight text: The user can perform the following steps to highlight text in a document.
	1. Select the text to display with the highlighted color. To do this, place the cursor at the beginning of the word, hold down your left mouse button, drag the mouse across the word or sentence and then release the mouse button.
	2. The box will appear.
	3. Click ().
	4. The pop up window will appear.
	5. Click Highlight and select the color from the list of available colors to highlight text with the selected color.
	 If you do not select color, the text will be highlighted with the default selected color.
	6. Provide the comments in the comment area.
	7. Click () to change the color of comment area. The color palette will appear. Select the required color from the list of available colors.
	8. Select the tag for the comments – correction, suggestion, fixed or important.
	 To provide new tag to the comments, click New tag text box.
	 Clicking the box will bring the text box in an editable mode.
	 Type the new tag name.
	 Click .
	 The new tag has been added in the tag list.
	9. Click Save.
	10. The comment has been highlighted in the page and is displayed in the right hand side of the viewer within a comment box.
	11. Click Edit to re-edit the comment.
	12. Click Reply to reply with your valuable feedback on the reviewed comments.
	13. Click Delete to delete comment.
	14. Click () to minimize comment box.
	15. The () icon is displayed at the highlighted text.
	16. Click () to read the comment of the highlighted text.
	4.18 Check Point

	The Check Point annotation is a great tool to assist users in reviewing and verifying forms. Users open the Check Point pane to quickly jump from area to area, verifying the information according to the instructions and mark each item as “Approved” or...
	1. On the Annotate tab, click Check Point () annotation tool.
	2. The pointer will change to tick mark.
	3. Move the pointer to the place to begin. Click and drag diagonally on the screen and release the mouse button.
	4. The comments dialog box will appear.
	5. Type the comments for the checkpoint in the text box and click the Save.
	6. The CheckPoint dialog box will pop up from the right hand side with your comments and two buttons – Accept and Reject.
	7. The reviewer will review the comments and if agree, will ‘Accept’ the comments otherwise ‘Reject’. Upon Accepting, the status will change from unchecked to Approved and other requisite information such as Approver’s name with date and time will app...
	8. On rejecting, the pop up will appear asking the reason of rejection. Type the reason in the provided text box and click OK.
	9. On Rejecting, the status will change from unchecked to Rejected and other requisite information such as Rejecters name with date and time and the reason of rejecting will appear in the Information section.
	4.19 SideNote

	The SideNote annotation enables reviewers to step through each Note annotation in the opened documents or images, review and add additional information and comments regarding an annotation, along with a complete audit trail of the comments. The user c...
	1. On the Annotate tab, click SideNote () annotation tool.
	2. Move the pointer to the place where you want the sidenote to begin. Click and drag diagonally on the screen and release the mouse button.
	3. The comments dialog box will appear.
	4. Type the title name of the side note in Enter the Title.
	5. Type the comments in the comments area.
	6. Select the option from the list of available options in both the drop down boxes.
	7. Click Save.
	8. The SideNote dialog box will pop up from the right hand side with your comments and the selected options.
	9. Click Add Reply to reply the comments.
	4.20 Launching eViewer from ICN IBM Content Navigator

	In ICN (IBM Content Navigator), the ‘Open Browse View’ contains various files and folders. The user can select document to meet the desired purpose in ‘eViewer’. It customizes user interface and offers usability enhancements for developers, administra...
	Further to add, the user can select multiple files and get it uploaded in eViewer, all at the same time. The user can select desired number of files; by and by press the open button. This provides support of seamless viewing to the user. The phenomeno...
	5. Annotation Text Search
	6. Adding Watermarks
	Watermarks are text or pictures that appear behind the document text. They often add interest or identify the document status, such as marking a document as a Draft, Confidential, and Urgent.
	eViewer provides a list of standard watermarks, or the user can create their own custom watermark, such as company logo. The user can perform the following steps to create a watermark:
	1. On the Annotate tab, click Add Watermark ().
	2. The Watermark dialog box will appear.
	3. Provide the details of the watermark corresponding to each field.
	4. Click OK.
	5. The watermark will be added on each page of the document.
	7. Bookmarking Pages in a Document
	A user working with a large document needs to return to a specific location in the document for any purpose, Bookmark feature can prove invaluable. Rather than having to scroll through the pages of the document, user can quickly jump to the marked pag...
	1. Go to the Thumbnail Window that lists all the pages of the document. If it is not open, go to the View tab, select Thumbnail check box.
	2. Hover mouse on the desired pages to place bookmark.
	3. The blue color icon () will display at the top left corner of the page.
	4. Click ().
	5. The selected page has been bookmarked successfully.
	6. Repeat the above steps to add multiple bookmarks in the document.
	Edit/remove bookmark pages:
	Bookmarks can be edited/removed by one of the following ways:
	 Menu option
	 Thumbnail Window option
	Through Menu Option:
	1. On the Annotate tab, click Add Bookmark ().
	2. The Edit Bookmark dialog box listing bookmarked and unbook marked pages of the document will appear.
	 The icon () corresponding to the pages are bookmark pages.
	3. To remove bookmark from any specific page, click () icon corresponding to that page.
	4. The () icon will become () signifies that bookmark has been removed successfully from the selected page.
	5. To add bookmark on the page, click () icon corresponding to the page. The () icon will become () signifies that bookmark has been added successfully on the selected page.
	6. Click Update.
	Through Thumbnail Window:
	1. Go to the Thumbnail Window that lists all the pages of the document. If it is not open, go to the View tab, select Thumbnail checkbox.
	2. The pages marked with blue color icon () are bookmark pages(s).
	3. To remove bookmark from the page, click () icon corresponding to that page.
	4. The icon will disappear from the selected page, signifies that the bookmark has been removed successfully from the page.
	8.   Search
	 8.1 Bookmarks
	 8.2 Annotation
	 8.3 Hide the Blank Page
	9.   Smart Redaction
	Several type of confidential information comes in the form of text patterns (Social Security numbers, account numbers, Date of Births, passport numbers, names) that needs to be removed from the documents. The eViewer provides a text pattern search cap...
	Smart Redaction works on all file formats supported by the eViewer including: Word, Excel, PDF, and TIFF. Redacted files can be published in any formats including PDF, TIFF, and any other image format. In the published file, anything redacted is perma...
	Perform the following steps to redact any specific text pattern in the document:
	1. On the Redact tab, select the category to redact text from the list of existing categories.
	2. Click ().
	3. The matched text based on the selected category will get highlighted in the document.
	4. To search the specific pattern of text, type the text in the text box, select the option as per the need - Case sensitive and Whole word and click ().
	 Case Sensitive: If selected, searches only for words that match the case of the word or phrase that has been typed in the text box. This means that the search becomes case-sensitive. For example, if you search menu, the result includes all instances...
	 Whole Word: If selected, restricts the search to whole words only. Whole words are words separated, on both sides, by a space. For example, if you search for edit, the result includes instances of edit only not editing, editor, editorial, and edited.
	 To redact the text, click () and drag over the text.
	5. The solid rectangle will display over the redacted text.
	6. To change the color of redaction, click ( ). The color palette appears. Select the color.
	10.   Shortcut Keys

